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1. Dulezité

Tato elektronickd uZivatelskd prirucka je

urena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uzivatelskou prirucku. Obsahuje dilezité

informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivan pro navrzenou potrebu v souladu
s ndvodem a po prilozenf origindlu faktury

nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf

¢islo vyrobku.

1.1 Bezpecnostni opatieni a udrzba

D Varovéni
Pouzitl kontrol, Uprav nebo postupt jinym

zpUsobem nez je stanoveno v této dokumentaci

mUZe vést k ohroZen( Sokem, elektrickym a/
nebo mechanickym rizikdim.

Prectéte si a dodrzujte tyto instrukce pri
zapojovani a pouzivani vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor primému slunecnimu

zéreni, velmi silnym jasnym svétldm a

udrzujte jej mimo dosah jinych zdrojl tepla.

Dlouhé vystaveni tomuto typu prostredf
muze mit za nasledek zménu barev a
poskozeni monitoru.

»  Odstrarite veskeré predméty, které by

mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky

monitoru.
*  Nezakryvejte vétracl otvory ve skiffice.

e Umistéte monitor na takové misto, ze

kterého bude elektricka zastrcka a zdsuvka

snadno pristupnd.

* Jestlize jste vypnuli monitor odpojenim

napdjectho kabelu nebo kabelu napdjectho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normalné.

Vzdy pouzivejte napdjeci kabel schvdleny
spolecnostf Philips. Pokud napd jecf kabel
chybi, obratte se na nejblizsi servisnf
stredisko. (Viz informace o strediscich
zdkaznické péce)

B&hem pouzivanl nevystavujte monitor
nadmémym otresim nebo ndrazim.

Pri pouzivani nebo premistovani do
monitoru nekopejte a zabrarite pripadnému
padu.

Udriba

Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmémy tlak. Pri premistovani zvedejte
monitor za ram; pri zvedani monitoru
nesahejte rukou nebo prsty na panel LCD.

Nebudete-li monitor delsi dobu pouZivat,
odpojte jej ze zdsuvky.

Pred ocisténim mimé navihéenym
hadrikem monitor odpojte ze zasuvky.

Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K cisténi monitoru nikdy
nepouzivejte organickd rozpoustédia, jako
napriklad alkohol nebo distice s obsahem
¢pavku.

Zabrarte nebezpec( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmémé vihkym
prostredim.

Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu

z monitoru a odeslete jej do servisniho
strediska.

Monitor neskladujte ani nepouZivejte
na mistech vystavenych teplu, pifmému
slunecnimu zdreni nebo extrémnim
teplotdm.

Chcete-li zachovat optimalnf vykonnost
monitoru a prodlouzit jeho Zivotnost,
pouZzivejte jej na mistg, které splfiuje
nasledujici rozsahy teplot a vihkosti.



»  Teplota: 0-40°C 32-95°F
e Vlhkost: 20-80% relativni vihkosti

Dilezité informace pro vypaleni obrazu/
zdvojeného dosvitu

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky. Bude-li
na vasem monitoru zobrazen neménicf
se staticky obsah, vzdy aktivujte aplikaci
pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchd”.
,Vypdleni*, ,,dosvit" nebo ,zobrazenf
duchd" je dobre zndmy jev u technologie
panell LCD. V mnoha pripadech , vypdlenf”,
,dosvit" nebo ,,zobrazeni duchd' postupné
zmizi po urcité dobé mimo provoz.

) Vystraha

Selhanf aktivace sporic¢e obrazovky nebo aplikace
pro pravidelné aktualizovanf obrazovky mize mit
za ndsledek vdzné priznaky ,vypdlenf", , dosvitu*
nebo ,zdvojeného dosvitu®, které nezmizi a
nelze je opravit. Na vySe uvedené poskozenf se
nevztahuje zdruka..

Servis

e Kryt plésté mdze otevrit pouze kvalifikovany
servisni pracovnik.

» Pokud je pro opravu vyzadovadna
dokumentace nebo integrace, obratte se
na nejblizsi servisni stiedisko. (Viz kapitola
, Stredisko zdkaznické péce™)

* Informace o prevézeni najdete v Cdsti
, Technické Udaje".

*  Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

& Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obratte se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisuji zpUsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strankdch této prirucky mizete narazit na
text, ktery je opatreny symbolem a je vytistén
tucné nebo kurzivou. Takové Useky obsahujf
pozndmky, upozomén a vystrahy. Jejich pouzitl
je nasledujict:

€ Pozniamka

Tento symbol oznacuje dlleZité informace a
navrhy, které pomédhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zaffzen( nebo ztrdte dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zafizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Sestaveni monitoru 2] Namontujte stojanek podstavce

1.
2.1 Instalace
2.
El Obsah krabice
Start
O 3,

Power Cable VGA Cable

Umistéte monitor obrazovkou dold na
mékky a hladky podklad, aby nedoslo k
poskrdban{ obrazovky.

Pripojte/nasurite sloupek podstavce k
monitoru tak, aby zacvakl na misto.

Uchopte monitor obéma rukama a
pripevnéte stojdnek podstavce do sloupku
podstavce.




3] Pripojeni k pocitaci

PHILIPS

o]

(1) Vstup stridavého napdjent
© VstupVGA
© émek proti krddeZi Kensington

Pripojeni k pocitaci

1.

2.

4,

5.

Pevné pripojte napdjecf kabel k zadnf strané
monitoru.

Vypnéte pocitac a odpojte jeho napdjecl
kabel.

Pripojte signdlovy kabel monitoru do video
konektoru na zadnf stran& pocftace.
Zapojte napdjeci kabel pocftace a monitoru
do nejblizsi zasuvky.

Zapnéte pocita¢ a monitor: Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

(1] Popis vyrobku z ¢elniho pohledu

2] Popis zobrazeni funkci na obrazovce

Co je nabidka na obrazovce (OSD)?

Funkcf nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

LCD Philips. Umozriuje koncovému uZivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru primo prostrednictvim
zobrazeného okna s pokyny. NiZe je uveden
priklad prjemného rozhrani obrazovky:

| Slouzi k ZAPNUTI a VYPNUTI
O napdjeni monitoru.

Nastaven( drovné jasu.

Nastaven( Urovné kontrastu.

Automatické nastaveni monitoru.

Nastaven( jazyka

(D Zobrazeni informacfl

D Ukonéeni OSD




Jak nastavit nabidku OSD jedinym tlacitkem?

1.Tlacftko na dolnf strané predniho rdmecku ma
funkce vypinace a nastaveni nabidky OSD.

PHILPS

1]

—r—

2 Jednim stisknutim dolniho tlacitka zapnéte
monitor.

3.Nynf dalsim stisknutim dolniho tlacftka na
prednim rdmecku vstupte do nabidky OSD

e -
4.Nyni mizete rychlym opakovanym stisknutim
dolniho tlacitka vybrat libovolnou funkci.
Tisknutim tlacitka se bude modré policko
posouvat vpravo. Jakmile modré poli¢ko oznacf
pozadovanou volbu, mizete dolnf tlacitko
uvolnit. Vybér je jednosmérny: vzdy postupuje
jednim smérem a potom se vréti na zacdtek
nabidky.

5.Modré policko zlstane na vybrané funkci
priblizné 3 sekundy, ikona funkce trikrdt zablikd
pro potvrzen( vybéru na 1. Urovni nabidky OSD
a funkce bude aktivovédna.

6.Chcete-li vybrat pozadovany jazyk, stisknéte
dolnf tlacitko, v nabidce OSD vyberte symbol
,zemékoule" a pockejte, az se aktivuje. V
nabidce se zobrazi n&kolik jazykovych moznost.
Opakovanym stisknutim dolniho tlacitka
prochdzejte jazyky. Ponechdnim modrého
poli¢ka na vybraném jazyku bude proveden
jeho vybér a aktivace.

7.Chcete-li nastavit jas nebo kontrast, stisknéte
dolnf tlacitko, vyberte a aktivujte. DalSimi
stisknutim dolntho tlacitka upravte. Vybér je
jednosmémy: vzdy postupuje jednim smérem a
potom se vrdti na zacdtek nabidky.

Nabidka OSD

NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdgji prozkoumat réiznd nastavent.

Main menu

— Power off

L Brightness — 0~100

— Contrast — 0~100

L Auto

t— Language — English, German, Spanish, Greek,
French, Italian, Hungarian, Dutch,
Portuguese, Portugués do Brazil,
Russian, Polish, Swedish, Finnish,
Tirk¢e, Czech, Ukrainian, S. Chinese,
T.Chinese, Japaness, Korean

Information
—  Exit



El Poznamka k rozligeni 2.3 Odpoijte stojanek podstavce a

Tento monitor je urcen pro optimdlni vykon pri podstavec
nativnim rozliseni 1366 x 768 pri 60 Hz. Kdyz je
monitor zapnut pi jiném rozli¥eni, na obrazovce Kl Demontiz stojanku podstavce

se zobrazf vystraha: Pro optimdini vysledek

Nez zacnete demontovat podstavec monitoru,
pouzijte rozliseni 1366 x 768 pii 60 Hz.

postupujte podle pokyni nize, aby se zabranilo
jakémukoli moznému poskozeni nebo zranént.
1. Umistéte monitor obrazovkou dol na
B Fyzické funkce mé&kky podklad, aby nedolo k poskrabani
N3 obrazovky.

aklon

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojenf sloupku podstavce stisknéte
uvolfiovaci tlacftko.




3. Optimalizace Obrazu

3.1 SmartContrast

El Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximalnf
vizudlni Cistotu a pozitek ze sledovani. Zvysuje
podsviceni pro jasnéjsi, ostr'ejs a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

B3 Pro¢ to potrebuiji?

Zadéte nejvy¥ vizudlni gistotu a pohodl
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky fdi kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazen( her a videa
nebo pro zobrazenf jasného, citelného textu
pro kanceldrskou praci. Omezenim spotreby
monitoru Setrite ndklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsviceni. Tato
funkce bude dynamicky vylepsovat kontrast pro
skvély zazitek pri prohlizenf fotografilf nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spolecnosti Phillips umozriuje ovladat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. Slozita nastavenf jsou
minulostf, protoze tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozli$enf, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovejsi
technologif v jddrovém algoritmu pro rychlé

zpracovan( a odezvu, je pripraven rozsiit vasi
zkusenost s monitory Philips!

El Instalace
»  Postupujte podle pokynd a dokoncete
instalaci.

*  Muzete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mizete klepnout
na zdstupce na pracovni ploSe nebo na
panel nastrojl.

PHILIPS

Prvni spusténi —Wizard (Priivodce)

*  Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Pr@vodce).

* Tento privodce vés provede podrobnym
nastavenim vykonu monitoru.

*  Privodce mizete rovnéz spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

*  Dalsi moznosti mlzete nastavit bez
pravodce prostrednictvim podokna
Standard (Standardni).
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B3 Spusténi s podoknem Standard

(Standardni):

Nabidka Adjust (Nastaveni):

Nabidka Adjust (Nastaveni) umoZzriuje
upravit Brightness (Jas), Contrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlisent).

MUzZete postupovat podle pokynd a provést
nastaven.

Cancel (Storno) vyzivéd uzivatele, chcete-li
ukoncit instalaci.
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3. Optimalizace Obraz
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Nabidka Color (Barva):

* Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroveﬁ cerné), White
Point (Bily bod), Color Calibration (Kalibrace
barev).

*  MuzZete postupovat podle pokynd a provést
nastaven.

* V nasledujici tabulce vyhledejte polozku
podnabidky na zakladé vaseho vstupu.

»  Priklad pro Color Calibration (Kalibrace
barev)
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3. Optimalizace Obrazu

1.

2.

Tlacftko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

Start (Spustit) — zahdjf sekvenci kalibrace
barev o 6. krocich.

Quick View (Rychlé zobrazeni) nacte
zobrazeni pred/po.

Chcete-li se vratit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

Enable color calibration (Povolit kalibraci
barev) — ve vychoz konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazenf nejsou k dispozici.

Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

Tlacftko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.
Tlacitko Next (Dalsi) slouzi k prechodu na
nasledujici cil (6 cil).

Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).
Tlacftko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviraci
nabidce Options (Moznosti). Na nepodporova-
ném zobrazovacim zafizeni s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpovéda)
a Options (MoZznosti).

I
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Zobraz{ nastavenf aktudlnich predvoleb.
Zaskrtnuté tlacftko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozf konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazf
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovni
ploge klepnutim pravym tlacftkem mysi na
mistn{ nabidku. Volbou moZnosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistn nabidku se zobrazf nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moZznosti
nabidky Help (Napovéda), Technical
Support (Odborna pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moZznost
EXIT (KONEC).



*  PoloZka Run at Startup (Spustit pfi startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovana, funkce
SmartControl Lite se nespusti pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovano), Zddnd predvolba nastavend
pro spustén( pfi startu nebude nactena.

*  Enable transparency mode (Aktivovat reZim
prahlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je 0 % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (MoZnosti). Zadné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

SmartControl Lite PHILIPS

Input
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» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudlniho zdroje vstupu.

» U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.

Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
B Sttt 2. i 22901 (rS30T18000001) (K
SmartCentrol Lite PHILIPS
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Help>User Manual (Napovéda>Uzivatelska
pfirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zafizen( s
podporou DDC/CI jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

U

SmartControl Lite PHILIPS

User Manual
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Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).

SmartControl Lite PHILIPS

Version

e inie e

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v casti
Options > podokno Preferences (Moznosti >

podokno Predvolby).

B SmartControl
Helect Preset L4
Tune Display

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouziti. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabfdce Ize rovnéz vybrat polozku
Predvolby vyrobce.

» Tune Display (Ladéni zobrazeni) — otevre
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacftkem Ize spustit aplikaci.

Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:

*  Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

»  Technical Support (Odbornd pomoc) —
zobrazi stranku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazi Uvodnf strdnku PDI a porovnd verzi
uzivatele s nejaktudlngsi dostupnou verz.

* About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vyddni a ndzev produktu.

*  Exit (Konec) - ukon¢i SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocftace nebo restartujte pocitac.

SmartControl

PHILIPS

SeartControl
‘Verzion 120
‘dune- standard-S2007-01-04-151.23
Copyright 19932007 Portrat Displays, Inc.
Patarts Panang




Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
¢ast EXIT (KONEC). Chcete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v ¢asti Options>Preferences
(MozZnosti>Predvolby).

& Pozndmka

Veskeré ilustrace v této casti jsou pouze
orientacni.Verze softwaru SmartControl se
mUze zménit bez predchoziho upozornén.
Vzdy navstivte oficidinil webové stranky Portrait
na adrese www.portrait.com/dtune/phl/enu/
index a stdhnéte si nejnoveési verzi softwaru
SmartControl.
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4. Technické udaje

Typ panelu LCD TFT-LCD
Podsvicenf LED

Velikost panelu 18,5" S (47 cm)
Pomér stran 16:9

Rozte¢ obrazovych bodl 0,3 x 0,3 mm
Jas 200 cd/m?
SmartContrast 10.000.000:1
Kontrastni pomér (typ.) 700:1

Doba odezvy (typickd) 5ms

Optimaln{ rozlisenf

1366 x 768 pii 60 Hz

Zorny Uhel

90° (H) / 65° (V) pfi C/R > 10

Barevnost displeje 16,7M
Vertikalni obnovovaci frekvence | 56Hz - 76Hz
HorizontdInf frekvence 30kHz - 83kHz
sRGB ANO

Usnadnéni

Usnadnénf pro uZzivatele

Moznosti pripojeni
Vstup signalu VGA (analogovy)
Vstupnf signdl Oddélend synchronizace, synchronizace podle zelené

193V5LSB23:
©)

Jazyky nabidky OSD

Anglictina, némcina, Spanélstina, rectina, francouzstina, italstina,
madarstina, holandstina, portugaltina, brazilskd portugalstina,
rustina, polstina, Svédstina, finstina, turectina, cestina, ukrajinstina,
zjednodusend ¢instina, tradiéni ¢instina, japonstina, korejstina

Dal3i usnadnéni

Zamek Kensington

Kompatibilita s technologif
Plug & Play

Podstavec
Naklon

DDC/CI, sRGB, Windows 8/ Windows 7/ Vista/XP, Mac OSX,
Linux

-3/+10

193V5LSB23:

Zapnuto 13,74W (typ.), 14,07W (max.)

Spének (Pohotovost) 0,5W

Vypnuto 0,5W

Indikator napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjenf Vypaleni, 100-240VAC, 50-60Hz
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Rozméry
Vyrobek s podstavce (SxVxH)

437 x 338 x 170 mm

Vyrobek bez podstavee (SxVxH)
Hmotnost

437 x 273 x 48 mm

Vyrobek s podstavcem 2,147kg
Vyrobek bez podstavce 1,940kg
Vyrobek s obalem 3,014kg

Provozni podminky

Teplotni rozsah (provoz) 0°C az 40 °C
Teplotnf rozsah (mimo provoz) -20°C az 60°C
Relativni vihkost 20% az 80%

MTBF 30 000 hod(LED)
ROHS ANO

Balenf 100% recyklovatelny
Barva Cemd

Povrchova Uprava Textura

© Poznamka

1. Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovejsi verzi letdku z webu

www.philips.com/support.




4.1 Rezimy rozliSeni a prredvoleb

Maximalni rozliseni
1366 x 768 pri 60 Hz

Vodorovna Rozliseni Svisla
frekvence frekvence
(kHz) (Hz)
3147 720 x 400 70.09
3147 640 x 480 59.94
35 640 x 480 66.67
37.86 640 x 480 72.81
375 640 x 480 75
37.88 800 x 600 60.32
46.88 800 x 600 75
48.36 1024 x 768 60
60.02 1024 x 768 75.03
44.77 1280 x 720 59.86
63.89 1280 x 1024 60.02
79.98 1280 x 1024 75.03
47.71 1366 x 768 59.79
& Poznimka

Upozormiujeme vds, Ze tento monitor funguje
nejlépe pri nativnim rozliseni 1366 x 768 pri
60 Hz. Pro dosazenf optimalni kvality zobrazenf
dodrzujte toto doporucené rozlisen.



5. Rizeni spotieby

Pokud je v daném pocitaci nainstalovdn software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
sniZit svou spotiebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpozna vstup z kldvesnice,

mysi nebo jiného vstupniho zarizenf, monitor se
automaticky ,,probudi*. Nésledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

193V5LSB23:

Rezim VESA| Video | H-synch. [ V-synch. | Spotreba energie | Barva indikdtoru LED
Aktivni ZAP. Ano Ano 13,74W (typ.) Bild
Spanek VYP. Ne Ne 0,5W (typ.) Bl (blikd)
Vypnuto | VYP. - - 05W (typ.) VYP.

Nasledujici konfigurace se pouzivd pri mérenf
energetické spotreby tohoto monitoru.

*  Nativni rozliseni: 1366 x 768

*  Kontrast: 50%

e Jas: 200 nitd

» Barevnd teplota: 6500 K's pIné bilym

vzorkem

& Poznamka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Péce o zdkazniky a zaruka

6.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi dodévat vyrobky
nejvyssi kvality. Pouziva nékolik nejpokrocilejsich
vyrobnich postupl vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych
bodl u paneld TFT LCD, které se pouzivajf

pro ploché monitory, se nicméné nékdy neda
zabranit. Zadny vyrobce nemiize zarudit, ze
vSechny panely budou bez defektd obrazovych
bod, ale spole¢nost Philips zarucuje, ze kazdy
monitor s neprijatelnym poctem defektl bude
v rdmci zaruky opraven nebo vymeénén. Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Unosnou urover chybovosti
pro kazdy druh. Aby bylo moZzné uplatnit zarucnf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodd panelu TFT LCD preséhnout
tuto Uroveri Unosnosti. Na monitoru napriklad
nesmi byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Déle, protoze nékteré typy
kombinaci vad pixell jsou Iépe postrehnutelné
nez jiné, stanovuje pro né spolecnost Philips
jesté vétsi ndroky na kvalitu. Tato norma se
dodrzuje celosveétove.

subpixely subpixely subpixely

vy
pixelly

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze trf
subpixeld v zakladnich barvdch cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadeé, tvorf
obraz. Kdyz vSechny subpixely urcitého pixelu
sviti, jevi se tyto tri subpixely spolecné jako
jediny bily pixel. Kdyz jsou vSechny tmavé, jevi
se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely réznych barev.

19

Druhy pixelovych vad

Vady pixell a subpixelt se na obrazovce
projevuji riiznymi zpUsoby. Existuji dva druhy
vad pixelu a v rdmci téchto druhd je nékolik
typl subpixelovych vad.

Defekty svétlych bodl

Defekty svétlych bodU se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dil¢r
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavd plocha. Existujf

nasledujici typy defektl svétlych bodl:

Jeden cerveny, zeleny nebo modry subpixel

l ¢

Dva soundlezici subpixely:
- lerveny + modry = fialovy
- Clerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel).



€& Poznamka

Cerveny nebo modry svétly bod musi byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasné&si, nez
sousedni body.

Defekty tmavych bodu

Defekty tmavych bodd se projevuji jako
obrazové body nebo dil¢i obrazové body, které
nikdy nesvitl nebo jsou , neaktivni*. Tmavy bod je
dilei obrazovy bod, ktery vystupuje z obrazovky,
kdyZz je na monitoru zobrazena svétld plocha.
Existuj nasledujici typy defektd tmavych bodu:

A A BOD

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixelt stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzdalenost vad pixelt.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vymeénu
kvadli defektnim obrazovym bodim v zdrucnf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bod
nebo dil¢ich obrazovych bodd, které prekracujf
tolerance uvedené v ndsledujicich tabulkach.

DR 1A Yo AD
1 trvale sviticf bod 3
2 sousedn( trvale svitici body 1
3 sousedni trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzdalenost mezi dvéma kazy jasnych bod* >15 mm
Celkovy pocet kazt jasnych bodd viech typl 3
A R BODU PRIJA PO AD
1 tmavy bod 5 nebo méné
2 sousedni tmavé body 2 nebo méné
3 sousedni tmavé body 0
Vzddlenost mezi dvéma kazy cernych bodd* >15 mm
Celkovy pocet kazt ¢ernych bodd viech typl 5 nebo méné

KAZy bodu celkem

Celkovy pocet kazt jasnych nebo ¢ernych bodud viech typl

PRIJATELNY POCET VAD
5 nebo méné

& Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod



6.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a pozadavku na dodatecnou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz muzete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich ¢&islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens 1&S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Greece Allman Hellas +30 00800 3122 1223 Free of charge
[taly A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNi A VYCHODNI EVROPY:

Telefonni stredisko ASC Cislo zakaznické péce
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
soroe fegm NA Kim Tec doo. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Hiaine NA E‘;ﬁ;;‘;wice +38 044 245 73 31
— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko Cislo zakaznické péce
Brazil 0800-7254101
Vermont
Argentina 0800 3330 856

Kontaktni informace pro Cinu:

Cina
Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Zemé Telefonni stredisko  ASC Cislo zakaznické péce
USA. EPl-e-center Qwantech (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni
stredisko

Cislo zakaznické péce

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
nd . NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
neonesia Prima 7511530
South Korea NA Alphascan Displays, Inc. 1661 — 5003
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA ftxd's Computer System Co. | (471 934-5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
. , +84 8 38248007 Ho Chi Minh City
Vietnam NA EPT Se“"c‘ft'crj‘forma“c +84 5113.562666 Danang City
ompany . +84 5113.562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d?strlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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7. Odstranovani problémd a
Casté dotazy

7.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy,
které mlZe odstranit uZivatel. Pokud problém
pretrvavd i po vyzkouseni téchto resent,
kontaktujte zdstupce sluzeb pro zékazniky
spolecnosti Philips.

Bl B&Zné problémy

Zadny obraz (indikator LED napajeni nesviti)

e Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadnf ¢dsti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajeni je bily)

e Zkontrolujte, zda je zapnuty pocitac.

e Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

» Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérte kabel.

*  Pravdépodobné je aktivovana funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Stru¢nd
prirucka).

e Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocitac.

Tlacitko AUTO nefunguje
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* Automaticka funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete provést rucnf
dpravy prostrednictvim nabidky OSD.

€& Pozniamka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdIni, protoze je zbytecna.

Viditelné znamky koure nebo jiskireni

*  Neprovadéjte zddné kroky pro odstrafiovénf
problémd

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

B Problémy se zobrazenim

Obraz neni vystredén

»  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladaci prvky OSD). Tato funkce je platna
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo k
pocitadi.

Dochazi ke svislému blikani

»  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

* Omezte svislé pruhy pomoci polozek
Phase/Clock (Féze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladaci prvky OSD). Tato funkce je platna
pouze v rezimu VGA.

Dochazi k vodorovnému blikani




*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v casti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit®, ,,vypaleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napijeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu muze
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchl'. ,Vypdleni*, ,dosvit"* nebo
,zobrazeni duch(" je dobre zndmy jev
u technologie paneld LCD. V mnoha
prpadech , vypdleni”, ,,dosvit"* nebo
,zobrazen( duchd" postupné zmizf po
urcité dob& mimo provoz.

» Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

*  Bude-li na vaSem monitoru LCD zobrazen
neménici se staticky obsah, vzdy aktivujte

aplikaci pro pravidelnou obnovu obrazovky.

*  Véiné priznaky ,vypdlen*, ,dosvitu" nebo
,zobrazeni duch" nezmizf a nelze je
opravit. Na vyse uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozlisenf zobrazenf pocitace
na stejny rezim, v jakém se nachdzf
doporucené nativni rozliseni obrazovky
monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

»  Zbyvajici body jsou normdlini vlastnostf
tekutych krystald pouZivanych soucasnou
technologii. Dalsi podrobnosti viz pravidla
pro obrazové body.
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Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

* MdZzete nastavit intenzitu svétla indikdtoru
,napdjeni* v casti Power LED (Indikdtor
LED napdjen) v casti Setup (Nastavent)
v OSD Main Controls (Hlavni ovlddact
prvky nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zakazniky a kontaktujte
zéstupce sluzeb pro zékazniky spolec¢nosti
Philips.

7.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozlisen( pro tento

monitor: 1366 x 768 pri 60 Hz.

*  Odpojte vSechny kabely, potom pripojte
pocita¢ k monitoru, ktery jste pouzili predtim.

* V Start Menu (nabidce Start) operacniho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazenf). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaven). Na karté nastavenf
v poli oznac¢eném ,,desktop area’ (pracovn(
plocha) presurite posuvnik na 1366 x 768
obrazovych bodu.

*  Klepnéte na, Advanced Properties' (Upresnit),
nastavte polozku Refresh Rate (Obnovovaci
frekvence) na 60 Hz a potom klepnéte na OK.

*  Restartujte pocitac a zopakovdnim kroku 2 a 3
ovérte, zda je pocita¢ nastaven na 1366 x 768
pri 60 Hz.

*  Vypnéte pocftac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

»  Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaki je doporuéena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovacf frekvence
u monitort LCD je 60 Hz. V pripadé

jakéhokoli ruseni na obrazovce ji

Odpovéd:



OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpoveéd:

OTAZKA 5:

Odpovéd:

OTAZKA é:

Odpoveéd:

OTAZKA 7:

Odpovéd:

mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmizf.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pri instalaci ovladact
postupujte podle pokynd v
uzivatelské prirucce. Pri prvnf instalaci
bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynl a
vlozte (doprovodny disk CD-ROM),
ktery je soucastf této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovany automaticky.

Jak mam upravit rozliseni?
Dostupna rozliseni urcuje grafickd
karta/ovladac grafiky a monitor.
Pozadované rozliseni mizete vybrat
v ¢asti Control Panel (Ovlddaci
panely) systému Windows® v &4sti
,Display properties" (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset" (Obnovit)
obnovte viechna plvodni nastaven(
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmérmym udderim
a chrdnit jej pred ostrymi nebo
tupymi predméty. Pfi manipulaci

s monitorem nevyvijejte na povrch
panelu zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zdrucnf
podminky.

Jak Ize Cistit povrch monitoru
LCD?
Pro bézné cisténi pouzijte Cisty
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a mekky hadrik. Pro ddkladné
cisténi pouzijte izopropyl
alkohol. Nepouzivejte zadnd jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?
Odpovéd:  Ano, nastaveni barev mizete zménit

prostrrednictvim nabidky OSD podle
nasledujicich krokd:

»  Stisknutim tlacftka ,,OK" zobrazte nabidku
OSD.

+ Stisknutim tlagitka ,Down" (Sipka dolt)
vyberte volbu ,,Color (Barva) a stisknutim
tlacitka ,,OK" prejdéte na nastaveni barev. K
dispozici jsou tfi nastaven( (viz nize).

1.

Color Temperature (Teplota barev):

k dispozici je dvou nastaveni: 6500K a
9300K. Pri nastaven( v rozsahu 6500K
vypadajf barvy na panelu ,teplé s
cervenobilym barevnym ténem", zatimco
pri nastaven( teploty 9300K vypadajf
barvy na panelu ,,studené s modrobilym
barevnym ténem".

sRGB: standard pro zajisténi spravné
prenosu barev mezi rdznymi zarizenimi
(napr:. digitalni fotoaparaty, monitory,
tiskdrny, skenery atd.)

User Define (Uzivatelské): uzivatel si mize
zvolit vlastni nastaveni barev upravenim
cervené, zelené a modré slozky.

€& Poznamka:

Méreni svétla barvy, které vyzaruje predmét pri
zahrfvéni. Toto mérenf je vyjadreno v absolutnim
méritku (stupné Kelvina). Nizsf teploty Kelvina,
napriklad 2004K; jsou cervené; vyssi teploty, jako
napriklad 9300K jsou modré. Neutrdini teplota je
bild pri 6504K.

OTAZKA 9:  Lze pfipojit tento monitor LCD
k libovolnému pocitaci, pracovni
stanici nebo pocitaci Mac?

Odpoveéd: Ano.Vsechny monitory LCD

Philips jsou pIné kompatibilni se
standardnimi pocitaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojenf monitoru k systému
Mac muze byt zapotrebf kabelovy



OTAZKA 10:

Odpovéd:

OTAZKA 11:

Odpovéd:

D Vystraha

adaptér. Dal3f informace vdm

zéstupce Philips.

Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologif Plug-
and-Play v operacnim systému
Windows 8,Windows 7,Vista, XP,
NT, Mac OSX a Linux.

Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,»duch® v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mdze zplsobit
,Vvypalen* obrazovky, rovnéz
znamé jako ,,dosvit" nebo
,zobrazenf duchd". , Vypdleni*,
,dosvit" nebo ,,zobrazeni duchd"
je dobre zndmy jev u technologie
panell LCD.V mnoha pripadech
,Vvypalenf*,, dosvit" nebo
,zobrazenf duchd" postupné zmizf
po urcité dobé mimo provoz.
Pred ponechdnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Selhdnf aktivace sporice obrazovky nebo aplikace
pro pravidelné aktualizovani obrazovky muze mit
za nasledek vazné priznaky ,,vypéleni*, ,dosvitu”
nebo ,,zdvojeného dosvitu”, které nezmizi' a
nelze je opravit. Na vySe uvedené poskozeni se
nevztahuje zaruka.
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OTAZKA 12: Proé se na displeji nezobrazuje

Odpoveéd:

ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V&3 monitor nejlépe pracuje pri
svém nativnim rozlisenf 1366

x 768 pri 60 Hz. Pouzivejte

toto rozliSenf pro dosazenf
optimédlniho zobrazen.
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